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1—Informacje o drukarce 
Korzystanie z panelu sterowania drukarki 

 

  Użyć By 

1 Wyświetlacza • Podejrzeć status drukarki i komunikaty. 

• Skonfigurować i obsługiwać drukarkę. 

2 Przycisków strzałek Przewijać w górę i w dół oraz w lewo i w prawo. 

3 Przycisku wyboru • Wybrać opcje menu. 

• Zapisać ustawienia. 

4 Przycisku książki adresowej Podejrzeć wszystkie zapisane adresy. 

5 Przycisku ponownego wybierania Podejrzeć ostatni numer, z którym nawiązane było 
połączenie. 

6 Klawiatury Wprowadzić numery, litery lub symbole. 

7 Przycisku Czuwania Włączyć tryb Czuwania lub Hibernacji. 

Wykonać poniższe działanie, by wybudzić drukarkę 
z trybu Czuwania: 

• Wcisnąć  (przycisk Czuwania). 

• Przesłać zadanie drukowania z komputera. 

• Wykonać reset przy włączeniu zasilania 
używając głównego wyłącznika zasilania. 

• Odebrać faks. 

8 Przycisku Anuluj Anulować wszystkie operacje będące w toku w 
drukarce. 
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  Użyć By 

9 Przycisku Start Zależnie od tego, który tryb jest wybrany, rozpocząć 
wykonywanie zadania. 

10 Przycisku Faksu Przesyłać faksy. 

11 Przycisku Cofnij Przywrócić poprzedni ekran. 

12 Przycisku strony głównej Przejść do ekranu głównego. 

13 Wskaźnika Sprawdzić status drukarki. 

  

Interpretacja kolorów przycisku Czuwania i wskaźników 
Kolory przycisku Czuwania i wskaźników znajdujących się na panelu sterowania drukarki oznaczają 
określone statusy lub warunki odnoszące się do drukarki. 

Kolor wskaźnika i odpowiadający mu status drukarki 

Wskaźnik Status drukarki 

Wył. Drukarka jest wyłączona lub aktywny jest jej tryb Hibernacji. 

Migające zielone światło Drukarka nagrzewa się, przetwarza dane lub drukuje. 

Stałe zielone światło Drukarka jest włączona, lecz nie wykonuje żadnego zadania. 

Migające czerwone światło Drukarka wymaga interwencji użytkownika. 

  

Kolor przycisku Czuwania i odpowiadający mu status drukarki 

Wskaźnik przycisku Czuwania Status drukarki 

Wył. Drukarka jest wyłączona, bezczynna lub w stanie Gotowości. 

Stałe bursztynowe światło W drukarce aktywny jest tryb Czuwania. 

Migające bursztynowe światło W drukarce trwa aktywacja lub dezaktywacja trybu Hibernacji. 

Migające bursztynowe światło przez 
0,1 sekundy, następnie całkowicie 
wygaszone przez 1,9 sekundy, powoli 
pulsujące 

W drukarce aktywny jest tryb Hibernacji. 
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2—Ładowanie papieru i nośników 
specjalnych 
Ustawianie formatu i rodzaju papieru 
1. Na panelu sterowania drukarki przejść do: 

 >Settings >  >Paper Menu >  >Paper Size/Type >  

2. Wcisnąć strzałkę w górę lub w dół, by wybrać tacę lub podajnik, a następnie nacisnąć . 

3. Wcisnąć strzałkę w górę lub w dół, by wybrać format papieru, a następnie nacisnąć . 

4. Wcisnąć strzałkę w górę lub w dół, by wybrać rodzaj papieru, a następnie nacisnąć , aby zmienić 
ustawienia. 

Konfiguracja uniwersalnych ustawień papieru 
Uniwersalny format papieru to ustawienie zdefiniowane przez użytkownika umożliwiające drukowanie na 
formatach papieru, które nie zostały wstępnie ustawione w menu drukarki. 

Uwagi: 

• Najmniejszym obsługiwanym Uniwersalnym formatem papieru jest 76,2 x 127 mm (3 x 5 cali), który 
jest obsługiwany wyłącznie w podajniku wielofunkcyjnym. 

• Największym obsługiwanym Uniwersalnym formatem papieru jest 215,9 x 355,6 mm (8,5 x 14 cali), 
który jest obsługiwany we wszystkich podajnikach. 

1. Na panelu sterowania drukarki przejść do: 

 >Settings >  >Paper Menu >  >Universal Setup >  >Units of Measure >  > 

wybrać jednostkę miary >  

2. Wybrać Portrait Width lub Portrait Height, a następnie nacisnąć . 

3. Wcisnąć przycisk strzałki w lewo lub w prawo, by zmienić ustawienie, a następnie nacisnąć . 

Ładowanie do podajników 

 OSTROŻNIE—ZAGROŻENIE OBRAŻENIAMI CIAŁA: Aby zmniejszyć ryzyko niestabilności 
urządzenia, każdy z podajników należy ładować osobno. Wszystkie pozostałe podajniki powinny 
pozostawać zamknięte do chwili, kiedy konieczne będzie ich otwarcie. 
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1. Podajnik wysunąć do końca. 

Uwaga: Podajników nie należy wysuwać podczas drukowania zadania lub kiedy na wyświetlaczu 
drukarki pokazywany jest komunikat Busy. Wysunięcie podajnika może wówczas spowodować 
zacięcie papieru. 

 

2. Ścisnąć, a następnie przesunąć uchwyt prowadnicy szerokości w odpowiednie położenie 
odpowiadające formatowi papieru, jaki jest ładowany. 
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3. Ścisnąć, a następnie przesunąć uchwyt prowadnicy długości w odpowiednie położenie 
odpowiadające formatowi papieru, jaki jest ładowany. 

 

Uwagi: 

- W przypadku niektórych formatów papieru, np. letter, legal i A4, należy ścisnąć i przesunąć 
uchwyt prowadnicy długości do tyłu, by jej ustawienie dopasować do długości tych formatów. 

- Kiedy ładowany jest papier o formacie legal, prowadnica długości wysuwana jest poza podstawę, 
pozostawiając papier wystawiony na działanie kurzu. Aby uchronić papier od kurzu, użytkownik 
może oddzielnie nabyć osłonę. Aby dowiedzieć się więcej, należy skontaktować się z pomocą 
techniczną. 

- Jeśli do podajnika standardowego ładowany jest papier o formacie A6, uchwyt prowadnicy 
długości należy ścisnąć i przesunąć w kierunku środka podajnika, w położenie formatu A6. 

- Dopilnować, aby prowadnice szerokości i długości były dopasowane do oznaczeń formatu 
papieru znajdujących się na dole podajnika. 
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4. Arkusze papieru należy wygiąć do siebie i od siebie, aby je poluzować i przekartkować. Papieru nie 
należy składać, ani zagniatać. Krawędzie wyprostować na płaskiej powierzchni. 

 

5. Załadować stos papieru. 

 

Uwagi: 

- Papier recyklingowany lub wcześniej zadrukowany ładować stroną, po której ma być 
zadrukowany, skierowaną do dołu. 
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- Papier z wcześniej wykonanymi otworami należy ładować tak, by otwory znajdowały się na górnej 
krawędzi położonej najbliżej przedniej części podajnika. 

- Papier firmowy należy ładować tak, by strona przeznaczona do zadrukowania skierowana była do 
dołu, a górna krawędź arkusza położona była najbliżej przedniej części podajnika. Aby wykonać 
drukowanie dwustronne, papier firmowy należy ładować tak, by strona przeznaczona do 
zadrukowania skierowana była do góry, a dolna krawędź arkusza położona była najbliżej 
przedniej części podajnika. 

- Należy pamiętać, by stos papieru nie wystawał ponad oznaczenie maksymalnej ilości papieru, 
znajdujące się na boku prowadnicy szerokości. 

 

6. Wsunąć podajnik. 
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7. Na panelu sterowania drukarki, w menu Papieru, ustawić format i rodzaj papieru odpowiadający 
papierowi załadowanemu do podajnika. 

Uwaga: Aby uniknąć zacięć papieru i problemów z jakością, należy ustawić poprawny format i rodzaj 
papieru. 

Ładowanie do podajnika wielofunkcyjnego 
Podajnika wielofunkcyjnego należy użyć, gdy wykonywane jest drukowanie na papierze o różnych 
formatach i rodzajach lub na nośnikach specjalnych, takich jak brystol, folie prezentacyjne i koperty. 
Można z niego również skorzystać do drukowania na pojedynczym arkuszu papieru firmowego. 

1. Otworzyć podajnik wielofunkcyjny. 

 

a. Wysunąć przedłużenie tacki podajnika wielofunkcyjnego. 
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b. Przedłużenie należy wysunąć ostrożnie tak, by podajnik wielofunkcyjny został całkowicie 
wysunięty i otwarty. 

 

2. Ścisnąć uchwyt znajdujący się na lewej prowadnicy szerokości, a następnie położenie prowadnic 
dopasować do ładowanego papieru. 

 

3. Przygotować papier lub nośnik specjalny do załadowania. 

- Arkusze papieru należy wygiąć do siebie i od siebie, by je poluzować i przekartkować. Papieru 
nie należy składać, ani marszczyć. Krawędzie wyprostować na płaskiej powierzchni. 
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- Folie prezentacyjne należy chwycić za krawędzie. Stos folii należy wygiąć do siebie i od siebie, 
by je poluzować i przekartkować. Krawędzie wyprostować na płaskiej powierzchni. 

Uwaga: Pamiętać, aby nie dotykać stron folii prezentacyjnych, po której mają być zadrukowane. 
Należy również zwrócić uwagę, by ich nie porysować. 

 

- Stos kopert należy wygiąć do siebie i od siebie, by je poluzować i przekartkować. Krawędzie 
wyprostować na płaskiej powierzchni. 

 

4. Załadować papier lub nośnik specjalny. 

Uwagi: 

- Papieru lub nośników specjalnych nie należy wkładać do podajnika wielofunkcyjnego na siłę. 

- Należy pamiętać, by stos papieru lub nośnika specjalnego nie wystawał ponad oznaczenie 
maksymalnej ilości papieru, znajdujące się na prowadnicach papieru. Włożenie nadmiernej ilości 
papieru może powodować zacięcia papieru. 
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- Załadować papier, folie prezentacyjne i brystol stroną, po której mają być zadrukowane, 
zwróconą do góry, a górną krawędzią skierowaną do wnętrza drukarki. Aby dowiedzieć się więcej 
na temat ładowania folii prezentacyjnych, patrz opakowanie w jakim zostały one nabyte. 

 
 

  

Uwaga: Kiedy ładowany jest papier o formacie A6, dopilnować, aby przedłużenie podajnika 
wielofunkcyjnego lekko dotykało krawędzi papieru tak, by ostatnich kilka arkuszy papieru 
pozostawało na miejscu. 
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- Papier firmowy należy załadować stroną przeznaczoną do zadrukowania skierowaną do góry i 
skierowany górną krawędzią do wnętrza drukarki. W przypadku drukowania dwustronnego 
(dupleksu), papier firmowy należy załadować stroną, po której ma być zadrukowany, zwróconą 
do dołu, a dolną krawędzią skierowany do wnętrza drukarki. 

 

- Koperty należy ładować zwrócone klapką w lewą stronę i stroną przeznaczoną do zadrukowaną 
skierowaną do dołu. 

 

Ostrzeżenie—Możliwość uszkodzenia: Nigdy nie używać kopert ze znaczkami, zapięciami, 
zatrzaskami, okienkami, powlekanych lub posiadających paski powleczone klejem. Takie koperty 
mogą spowodować poważne uszkodzenie drukarki. 

5. Na panelu sterowania drukarki, w menu Papieru, ustawić format i rodzaj papieru odpowiadający 
papierowi lub nośnikowi specjalnemu załadowanemu do podajnika wielofunkcyjnego. 
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Łączenie i rozłączanie podajników 

Łączenie i rozłączanie podajników 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki na panelu sterowania drukarki w części TCP/IP, w menu 
Network/Ports. Adres IP ma format czterech grup cyfr oddzielonych kropkami, np. 
123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. Kliknąć Settings >Paper Menu. 

3. Dla łączonych podajników należy zmienić ustawienia formatu i rodzaju papieru. 

- Aby połączyć podajniki, należy sprawdzić, czy format i rodzaj papieru ustawiony dla jednego 
podajnika jest taki sam, jak dla drugiego podajnika. 

- Aby rozłączyć podajniki, należy dopilnować, aby format lub rodzaj papieru ustawiony dla jednego 
podajnika był inny, niż w przypadku drugiego podajnika. 

4. Kliknąć Submit. 

Uwaga: Ustawienia formatu i rodzaju papieru można również zmienić korzystając z panelu sterowania 
drukarki. Aby dowiedzieć się więcej, patrz Ustawianie formatu i rodzaju papieru. 

Ostrzeżenie—Możliwość uszkodzenia: Papier załadowany do podajnika powinien odpowiadać nazwie 
rodzaju papieru przypisanej w drukarce. Temperatura zespołu utrwalającego jest różna, zależnie od 
określonego rodzaju papieru. Jeśli ustawienia nie zostaną poprawnie skonfigurowane, podczas 
drukowania mogą wystąpić problemy. 

Tworzenie niestandardowej nazwy rodzaju papieru 

Korzystanie z Osadzonego serwera sieci Web 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. Kliknąć Settings >Paper Menu >Custom Names. 

3. Wybrać nazwę niestandardową, a następnie wpisać nową nazwę rodzaju papieru użytkownika. 

4. Kliknąć Submit. 
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5. Kliknąć Custom Types, a następnie sprawdzić, czy nowa nazwa niestandardowa rodzaju papieru 
zastąpiła nazwę użytkownika. 

Korzystanie z panelu sterowania drukarki 

1. Na panelu sterowania drukarki przejść do: 

 >Settings >  >Paper Menu >  >Custom Names 

2. Wybrać nazwę niestandardową, a następnie wpisać nową nazwę rodzaju papieru użytkownika. 

3. Wcisnąć . 

4. Wcisnąć Custom Types, a następnie sprawdzić, czy nowa nazwa niestandardowa rodzaju papieru 
zastąpiła nazwę użytkownika. 

Przypisywanie niestandardowej nazwy rodzaju papieru 

Korzystanie z Osadzonego serwera sieci Web 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. Kliknąć Settings >Paper Menu >Custom Names. 

3. Wpisać nazwę rodzaju papieru, a następnie kliknąć Submit. 

4. Wybrać typ niestandardowy, a następnie sprawdzić, czy poprawny rodzaj papieru został przypisany 
do nazwy niestandardowej. 

Uwaga: Zwykły papier stanowi fabryczny, domyślny rodzaj papieru ustawiony dla wszystkich nazw 
niestandardowych zdefiniowanych przez użytkownika. 

Korzystanie z panelu sterowania drukarki 

1. Na panelu sterowania drukarki przejść do: 

 >Settings >  >Paper Menu >  >Custom Names 

2. Wpisać nazwę rodzaju papieru, a następnie wcisnąć . 
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Przypisywanie niestandardowego rodzaju papieru 

Korzystanie z Osadzonego serwera sieci Web 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. Kliknąć Settings >Paper Menu >Custom Types. 

3. Wybrać niestandardową nazwę rodzaju papieru, a następnie wybrać rodzaj papieru. 

Uwaga: Papier stanowi fabryczny, domyślny rodzaj papieru ustawiony dla wszystkich nazw 
niestandardowych zdefiniowanych przez użytkownika. 

4. Kliknąć Submit. 

Korzystanie z panelu sterowania drukarki 

1. Na panelu sterowania drukarki przejść do: 

 >Settings >  >Paper Menu >  >Custom Types 

2. Wybrać niestandardową nazwę rodzaju papieru, a następnie wybrać rodzaj papieru. 

Uwaga: Papier stanowi fabryczny, domyślny rodzaj papieru ustawiony dla wszystkich nazw 
niestandardowych zdefiniowanych przez użytkownika. 

3. Wcisnąć . 
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3—Drukowanie 
Drukowanie dokumentu 

Drukowanie dokumentu 

1. W menu Papieru, dostępnym na panelu sterowania drukarki, ustawić taki format i rodzaj papieru, by 
odpowiadał załadowanemu papierowi. 

2. Przesłać zadanie wydruku: 

Dotyczy użytkowników systemu Windows 

a. W otwartym dokumencie kliknąć File >Print. 

b. Kliknąć Properties, Preferences, Options lub Setup. 

c. Jeśli zachodzi taka potrzeba, wyregulować ustawienia. 

d. Kliknąć OK >Print. 

 

Uwaga: Aby poznać szczegółowe informacje na temat ustawień preferencji drukowania, patrz 
Pomoc odnosząca się do Sterownika. 
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Dotyczy użytkowników systemu Macintosh 

a. Jeśli zachodzi taka potrzeba, dostosować ustawienia w oknie dialogowym Page Setup: 

1. W otwartym dokumencie wybrać File >Page Setup. 

2. Wybrać format papieru lub utworzyć format niestandardowy odpowiadający załadowanemu 
papierowi. 

3. Kliknąć OK. 

b. Jeśli zachodzi taka potrzeba, dostosować ustawienia w oknie dialogowym Page Setup: 

1. W otwartym dokumencie wybrać File >Print. 

Jeśli zachodzi taka potrzeba, kliknąć trójkąt, by rozwinąć więcej opcji. 

2. Jeśli zachodzi taka potrzeba, wyregulować ustawienia w oknie dialogowym Print i w menu 
wyskakujących. 

Uwaga: Aby drukować na określonym rodzaju papieru, ustawienie rodzaju papieru należy tak 
wyregulować, by odpowiadało załadowanemu papierowi, albo wybrać odpowiedni podajnik. 

3. Kliknąć Print. 

Regulowanie zaczernienia tonera 

Korzystanie z Osadzonego serwera sieci Web 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. Kliknąć Settings >Print Settings >Quality Menu >Toner Darkness. 

3. Wyregulować zaczernienie tonera, a następnie kliknąć Submit. 

Korzystanie z panelu sterowania drukarki 

1. Na panelu sterowania drukarki przejść do: 

 >Settings >  >Print Settings >  >Quality Menu >  >Toner Darkness 

2. Wyregulować zaczernienie tonera, a następnie nacisnąć . 
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Anulowanie zadania drukowania 

Anulowanie zadania drukowania z panelu sterowania drukarki 

Na panelu sterowania drukarki wcisnąć . Kiedy pokazana zostanie lista zadań wydruku, wybrać 

zadanie, które ma być anulowane, a następnie nacisnąć . 

Anulowanie zadania drukowania z komputera 

Dotyczy użytkowników systemu Windows 

1. Otworzyć folder drukarek. 

W systemie Windows 8 

W panelu wyszukiwania wpisać run, a następnie przejść do: 

Listy aplikacji >Uruchom > wpisać control printers >OK 

W systemie Windows 7 lub starszych 

a. Kliknąć  lub kliknąć Start, a następnie kliknąć Uruchom. 

b. W oknie dialogowym Rozpocznij wyszukiwanie lub Uruchom wpisać control printers. 

c. Wcisnąć Enter lub kliknąć OK. 

2. Dwukrotnie kliknąć ikonę drukarki. 

3. Wybrać zadanie wydruku, które ma zostać anulowane. 

4. Kliknąć Usuń. 

Dotyczy użytkowników systemu Macintosh 

1. W menu Apple przejść do jednej z poniższych pozycji: 

- (W przypadku Mac OS X v10.3/v10.4/v10.5/v10.6)  
System Preferences >Print & Fax > wybrać drukarkę >Open Print Queue 

- (W przypadku Mac OS X v10.7/10.8) 
System Preferences >Print & Scan > wybrać drukarkę >Open Print Queue 

2. W oknie drukarki wybrać zadanie wydruku, które ma być anulowane, a następnie usunąć je. 
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4—Kopiowanie 
Tworzenie kopii 

Tworzenie szybkiej kopii 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF lub stroną zadrukowaną zwrócony do dołu na szybie skanera. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych z 
magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany, wskaźnik ADF zapali się. 

2. Jeśli dokument jest ładowany do podajnika ADF, należy dopasować położenie prowadnic papieru. 

Uwaga: Aby uniknąć przycięcia obrazu, należy sprawdzić, czy format dokumentu oryginału i format 
papieru do kopiowania są takie same. 

3. Na panelu sterowania drukarki wcisnąć . 

Kopiowanie z wykorzystaniem ADF 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych 
z magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany, wskaźnik ADF zapali się. 

2. Wyregulować położenie prowadnic papieru. 

3. Na panelu sterowania drukarki użyć klawiatury, by wprowadzić liczbę kopii, a następnie nacisnąć . 

Kopiowanie z wykorzystaniem szyby skanera 

1. Dokument oryginału umieścić stroną zadrukowaną do dołu na szybie skanera, w jej górnym lewym 
rogu. 
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2. Na panelu sterowania drukarki użyć klawiatury, by wprowadzić liczbę kopii, a następnie nacisnąć . 

Uwaga: Jeśli użytkownik chce zeskanować następny dokument, powinien położyć go na szybie 
skanera, wcisnąć przycisk strzałki w lewo lub w prawo, by przewinąć do Scan the Next Page, a 

następnie nacisnąć . 

3. Wcisnąć przycisk strzałki w lewo lub w prawo, by przewinąć do Finish the Job, a następnie 

nacisnąć . 

Kopiowanie zdjęć 
1. Zdjęcie umieścić stroną zadrukowaną do dołu na szybie skanera, w jej górnym lewym rogu. 

2. Na panelu sterowania drukarki przejść do: 

 >Copy >  >Content Type >Photo 

3. Z menu Źródło zawartości wybrać ustawienie najlepiej opisujące oryginalne zdjęcie, które jest 

kopiowane, a następnie nacisnąć . 

Uwaga: Jeśli użytkownik chce skopiować następne zdjęcie, powinien położyć je na szybie skanera, 
wcisnąć przycisk strzałki w lewo lub w prawo, by przewinąć do Scan the Next Page, a następnie 

nacisnąć . 

4. Wcisnąć przycisk strzałki w lewo lub w prawo, by przewinąć do Finish the Job, a następnie 

nacisnąć . 

Anulowanie zadania kopiowania 

Anulowanie zadania kopiowania z panelu sterowania drukarki 

Na panelu sterowania drukarki wcisnąć . 
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5—Przesyłanie wiadomości e-mail 
Konfiguracja drukarki w celu przesyłania wiadomości 
e-mail 

Konfiguracja funkcji przesyłania wiadomości e-mail 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. Kliknąć Settings >E-mail/FTP Settings >E-mail Settings. 

3. Wprowadzić odpowiednie informacje, a następnie kliknąć Submit. 

Konfiguracja ustawień e-mail 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. Kliknąć Settings >E-mail/FTP Settings >E-mail Settings. 

3. Wprowadzić odpowiednie informacje, a następnie kliknąć Submit. 

Tworzenie skrótu e-mail 

Tworzenie skrótu e-mail z wykorzystaniem Osadzonego serwera sieci Web 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 
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2. Kliknąć Settings >Manage Shortcuts > E-mail Shortcut Setup. 

3. Wpisać nazwę skrótu, a następnie wprowadzić adres e-mail. 

Uwaga: Jeśli wprowadzanych jest kilka adresów, każdy z nich należy oddzielić przecinkiem (,). 

4. Jeśli zachodzi taka potrzeba, wyregulować ustawienia skanowania. 

5. Wprowadzić numer skrótu, a następnie kliknąć Add. 

Jeśli wprowadzony zostanie numer, który jest już używany, urządzenie zażąda wybrania innego 
numeru. 

Anulowanie wiadomości e-mail 

Na panelu sterowania drukarki wcisnąć . 
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6—Faksowanie 
Przesyłanie faksu 

Przesyłanie faksu z wykorzystaniem panelu sterowania drukarki 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF lub stroną zadrukowaną zwrócony do dołu na szybie skanera. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych z 
magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany, wskaźnik ADF zapali się. 

2. Jeśli dokument jest ładowany do podajnika ADF, należy dopasować położenie prowadnic papieru. 

3. Na panelu sterowania drukarki przejść do: 

 >Fax >  > używając klawiatury wprowadzić numer faksu lub skrótu >  >Original Size 

>  

Uwaga: Jeśli użytkownik chce przefaksować następny dokument, powinien położyć go na szybie 
skanera, wcisnąć przycisk strzałki w lewo lub w prawo, by przewinąć do Scan the Next Page, a 

następnie nacisnąć . 

4. Wcisnąć przycisk strzałki w lewo lub w prawo, by przewinąć do Finish the Job, a następnie 

nacisnąć . 

Przesyłanie faksu z wykorzystaniem komputera 

Opcja faksu sterownika drukarki umożliwia przesłanie zadania wydruku do drukarki, która następnie 
przesyła zadanie do odbiorcy jako faks. Opcja faksu działa jak zwykłe urządzenie faksu, kontrolowana 
jest jednak przez sterownik drukarki, a nie przez panel sterowania drukarki. 

1. W otwartym dokumencie kliknąć File >Print. 

2. Wybrać drukarkę, a następnie kliknąć Properties, Preferences, Options lub Setup. 

3. Przejść do: 

zakładki Fax >Enable fax 

4. W polu "Fax number(s)" wprowadzić należy numer lub numery faksu odbiorcy. 

Uwaga: Numery faksu można wprowadzać ręcznie lub z wykorzystaniem funkcji Książki telefonicznej 

5. Jeśli zachodzi taka potrzeba, w polu "Dialing prefix" należy wprowadzić odpowiedni prefiks. 



Przewodnik 

 
- 28 - 

6. Wybrać odpowiedni format papieru i ułożenie strony. 

7. Jeśli do faksu załączona ma być okładka, należy wybrać Include cover page with fax, a następnie 
wprowadzić odpowiednie informacje. 

8. Kliknąć OK. 

Uwagi: 

• Aby poznać informacje na temat instalowania tych sterowników, patrz płyta CD Sterowniki i 
dokumentacja (Drivers and Documentation). 

• Jeśli zaznaczone zostanie pole wyboru Always display settings prior to faxing, przed przesłaniem 
faksu użytkownik zostanie poproszony o sprawdzenie informacji dotyczących odbiorcy. Jeśli to pole 
wyboru nie jest zaznaczone, gdy na zakładce Faksu użytkownik kliknie OK, dokument oczekujący w 
kolejce automatycznie jest przesyłany jako faks. 

Przesyłanie faksu z wykorzystaniem numeru skrótu 

Skróty faksu pełnią rolę podobną do numerów skróconego wybierania w telefonie lub w faksie. Numer 
skrótu (1–999) może odnosić się do pojedynczego odbiorcy lub do kilku odbiorców. 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF lub stroną zadrukowaną zwrócony do dołu na szybie skanera. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych z 
magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany, wskaźnik ADF zapali się. 

2. Jeśli dokument jest ładowany do podajnika ADF, należy dopasować położenie prowadnic papieru. 

3. Wcisnąć #, a następnie wprowadzić numer skrótu używając klawiatury. 

4. Wcisnąć . 

Przesyłanie faksu z wykorzystaniem książki adresowej 

Funkcja książki adresowej umożliwia wyszukiwanie zakładek oraz serwerów katalogów sieciowych. 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF lub stroną zadrukowaną zwrócony do dołu na szybie skanera. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych z 
magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany, wskaźnik ADF zapali się. 

2. Jeśli dokument jest ładowany do podajnika ADF, należy dopasować położenie prowadnic papieru. 
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3. Na panelu sterowania drukarki przejść do: 

 >Fax >  >  > wybrać nazwę odbiorcy >  

Przesyłanie faksu o określonej godzinie 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF lub stroną zadrukowaną zwrócony do dołu na szybie skanera. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych z 
magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany do podajnika ADF, wskaźnik ADF zapali się. 

2. Jeśli dokument jest ładowany do podajnika ADF, należy dopasować położenie prowadnic papieru. 

3. Na panelu sterowania drukarki przejść do: 

 >Fax >  > wprowadzić numer faksu >Delayed Send >Send Later > wybrać datę, kiedy faks 

ma być przesłany >  > wybrać godzinę, o której faks ma być przesłany >  

4. Wcisnąć . 

Uwaga: Dokument jest skanowany, a następnie faksowany o ustalonej godzinie. 

Tworzenie skrótu odbiorcy faksu 

Tworzenie skrótu odbiorcy faksu z wykorzystaniem Osadzonego serwera sieci 
Web 

Przypisać numer skrótu do pojedynczego numeru faksu lub do grupy numerów faksu. 

1. Otworzyć przeglądarkę internetową, a następnie w polu adresu wpisać adres IP drukarki. 

Uwagi: 

- Podejrzeć adres IP drukarki w części TCP/IP, w menu Network/Ports. Adres IP ma format 
czterech grup cyfr oddzielonych kropkami, np. 123.123.123.123. 

- Jeśli użytkownik korzysta z serwera proxy, powinien tymczasowo go wyłączyć, by poprawnie 
załadować stronę sieci Web. 

2. kliknąć Settings >Manage Shortcuts > Fax Shortcut Setup. 

Uwaga: Wymagane może okazać się hasło. Jeśli użytkownik nie posiada ID i hasła, powinien 
skontaktować się z osobą odpowiedzialną za obsługę systemu. 
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3. Wpisać nazwę skrótu, a następnie wprowadzić numer faksu. 

Uwagi: 

- Aby utworzyć skrót odnoszący się do kilku numerów faksu, należy wprowadzić numery faksów 
grupy. 

- Każdy z numerów faksu należących do grupy oddzielić należy średnikiem (;). 

4. Przypisać numer skrótu. 

Uwaga: Jeśli wprowadzony zostanie numer, który jest już używany, urządzenie zażąda wybrania 
innego numeru. 

5. Kliknąć Add. 

Anulowanie wysłania faksu 

Anulowanie zadania faksowania, gdy dokumenty oryginału wciąż są skanowane 

• Jeśli wykorzystywany jest podajnik ADF i wyświetlone zostanie Scanning page, należy 

nacisnąć . 

• Jeśli wykorzystywana jest szyba skanera i wyświetlone zostanie Scanning page, Scan the Next 

Page lub Finish the Job, należy nacisnąć . 

Anulowanie zadania faksowania po zeskanowaniu dokumentów oryginału 

1. Na panelu sterowania drukarki wcisnąć . 

2. Wcisnąć przycisk strzałki w lewo lub w prawo, by przewinąć do zadania, które ma być anulowane. 

3. Wcisnąć  >Delete Selected Jobs. 
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7—Skanowanie 
Skanowanie do adresu FTP 

Skanowanie do adresu FTP 

Skanowanie do adresu FTP z wykorzystaniem numeru skrótu 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF lub stroną zadrukowaną zwrócony do dołu na szybie skanera. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych z 
magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany, wskaźnik ADF zapali się. 

2. Jeśli dokument jest ładowany do podajnika ADF, należy dopasować położenie prowadnic papieru. 

3. Na panelu sterowania drukarki wcisnąć #, a następnie wprowadzić numer skrótu FTP. 

4. Wcisnąć . 

Skanowanie do adresu FTP z wykorzystaniem książki adresowej 

1. Dokument oryginału załadować stroną zadrukowaną zwrócony do góry, krótką krawędzią skierowany 
do wnętrza podajnika ADF lub stroną zadrukowaną zwrócony do dołu na szybie skanera. 

Uwagi: 

- Do podajnika ADF nie należy ładować pocztówek, zdjęć, małych przedmiotów, folii 
prezentacyjnych, papieru fotograficznego, ani cienkich nośników (np. artykułów wyciętych z 
magazynów). Przedmioty takie należy umieszczać na szybie skanera. 

- Kiedy papier zostanie poprawnie załadowany, wskaźnik ADF zapali się. 

2. Jeśli dokument jest ładowany do podajnika ADF, należy dopasować położenie prowadnic papieru. 

3. Na panelu sterowania drukarki przejść do: 

 >FTP Shortcuts >  > wybrać nazwę odbiorcy >  
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8—Usuwanie zacięć papieru 
Komunikaty o zacięciu papieru wyświetlane są na ekranie drukarki. Zwierają one informacje o obszarze, 
gdzie zacięcie wystąpiło. Jeśli papier uległ zacięciu w kilku miejscach, wyświetlana jest liczba zaciętych 
stron. 

Unikanie zacięć papieru 
Poprawne ładowanie papieru 

• Sprawdzić, czy papier leży płasko w podajniku. 

Poprawne ładowanie papieru Niepoprawne ładowanie papieru 

  

  

• Kiedy drukarka wykonuje wydruk, nie należy wysuwać podajnika. 

• Kiedy drukarka wykonuje wydruk, do podajnika nie należy ładować papieru. Papier należy załadować 
przed drukowaniem lub zaczekać na monit, by go załadować. 

• Nie należy ładować nadmiernej ilości papieru. Należy sprawdzić, czy wysokość stosu nie wychodzi 
ponad wskaźnik maksymalnej ilości papieru. 
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• Papieru nie należy wsuwać do podajnika. Należy go ładować tak, jak zostało to pokazane na ilustracji. 

 

• Sprawdzić, czy prowadnice w podajniku lub w podajniku wielofunkcyjnym znajdują się w poprawnym 
położeniu, oraz czy nie przywierają ściśle do krawędzi papieru lub kopert. 

• Po załadowaniu papieru podajnik wepchnąć pewnie do drukarki. 

Należy stosować zalecany papier 

• Należy używać jedynie zalecanego papieru lub nośników specjalnych. 

• Nie należy ładować pomarszczonego, pofałdowanego, wilgotnego, pogiętego, ani pozawijanego 
papieru. 

• Stos papieru należy powyginać, przekartkować i wyprostować przed załadowaniem. 

 

• Nie należy używać papieru, który został odcięty lub przycięty ręcznie. 

• W pojedynczym podajniku nie należy mieszać formatów papieru, gramatur, ani rodzajów papieru. 

• W komputerze lub na panelu sterowania drukarki należy sprawdzić, czy format i rodzaj papieru 
zostały ustawione poprawnie. 

• Papier należy przechowywać zgodnie z zaleceniami producenta. 
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Odczytywanie komunikatów i lokalizacji związanych z 
zacięciami papieru 
Kiedy wystąpi zacięcie papieru, na ekranie drukarki wyświetlany jest komunikat wskazujący lokalizację 
zacięcia i informacje umożliwiające usunięcie go. Aby usunąć zacięcie papieru, należy otworzyć drzwi, 
pokrywy i podajniki wskazane na ekranie. 

Uwagi: 

• Kiedy Pomoc przy zacięciach jest włączona, po usunięciu zacięcia drukarka automatycznie opróżnia 
puste strony lub strony częściowo zadrukowane do zasobnika standardowego. Należy sprawdzić, czy 
w stosie wydruków nie ma odrzuconych stron. 

• Kiedy w Usuwaniu zacięcia ustawiona jest opcja Wł. lub Auto, drukarka automatycznie ponownie 
drukuje zacięte strony. Ustawienie Auto nie gwarantuje jednak, że strona zostanie wydrukowana 
ponownie. 

 

  Obszar 
wystąpienia 
zacięcia 

Komunikat na panelu sterowania 
drukarki 

Co należy zrobić 

1 Automatyczny 
Podajnik 
Dokumentów 
(ADF) 

[x]-page jam, open automatic feeder top 
cover. [28y.xx] (Zacięta strona [x], otwórz 
górną pokrywę podajnika 
automatycznego. [28y.xx]) 

Wyjąć cały papier z podajnika ADF, a 
następnie usunąć zacięty papier. 

2 Zasobnik 
standardowy 

[x]-page jam, clear standard bin. [20y.xx] 
(Zacięta strona [x], wyczyść zasobnik 
standardowy. [20y.xx]) 

Usunąć zacięty papier. 

3 Drzwiczki 
przednie 

[x]-page jam, open front door. [20y.xx] 
(Zacięta strona [x], otwórz przednie 
drzwiczki. [20y.xx]) 

Otworzyć przednie drzwiczki, wyjąć 
zasobnik z tonerem i wkład 
światłoczuły, a następnie usunąć 
zacięty papier. 

4 Podajnik 
wielozadaniowy 

[x]-page jam, clear manual 
feeder. [25y.xx] (Zacięta strona [x], 
wyczyść zasobnik ręczny. [25y.xx]) 

Wyjąć cały papier z podajnika 
wielofunkcyjnego, a następnie 
usunąć zacięty papier. 
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  Obszar 
wystąpienia 
zacięcia 

Komunikat na panelu sterowania 
drukarki 

Co należy zrobić 

5 Podajnik 1 [x]-page jam, remove tray 1 to clear 
duplex. [23y.xx] (Zacięta strona [x], wyjmij 
podajnik 1, by oczyścić dupleks. [23y.xx]) 

Całkowicie wysunąć podajnik 1, 
wcisnąć do dołu klapkę przedniego 
dupleksu, a następnie usunąć zacięty 
papier. 

Uwaga: W przypadku niektórych 
zacięć papieru 23y.xx konieczne 
może okazać się otwarcie tylnych 
drzwiczek. 

6 Podajnik [x] [x]-page jam, remove tray [x]. [24y.xx] 
(Zacięta strona [x], wyjmij podajnik 
[x]. [24y.xx]) 

Wysunąć wskazany podajnik, a 
następnie usunąć zacięty papier. 

7 Tylne drzwiczki [x]-page jam, open rear door. [20y.xx] 
(Zacięta strona [x], otwórz tylne 
drzwiczki. [20y.xx]) 

Otworzyć tylne drzwiczki, a następnie 
usunąć zacięty papier. 

  

[x]-page jam, open front door. [20y.xx] 

 OSTROŻNIE—GORĄCA POWIERZCHNIA: Wnętrze drukarki może być gorące. Aby zmniejszyć 
ryzyko obrażeń spowodowanych gorącym elementem, przed dotknięciem należy zaczekać, aż 
powierzchnia ostygnie. 

1. Wcisnąć przycisk znajdujący się z prawej strony drukarki, a następnie otworzyć przednie drzwiczki. 
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2. Zasobnik na toner należy wysunąć używając uchwytu. 

 

3. Unieść niebieski uchwyt, a następnie wysunąć wkład światłoczuły z drukarki. 

 

Ostrzeżenie—Możliwość uszkodzenia: Nie należy dotykać błyszczącego, niebieskiego bębna 
fotoprzewodnika znajdującego się pod wkładem światłoczułym. Dotknięcie go może mieć negatywny 
wpływ na jakość wykonywanych w przyszłości zadań wydruku. 

 

4. Wkład światłoczuły należy odłożyć na bok na płaską, gładką powierzchnię. 

Ostrożnie—Możliwość uszkodzenia: Wkładu światłoczułego nie należy wystawiać na bezpośrednie 
działanie światła przez czas dłuższy, niż 10 minut. Dłuższe oddziaływanie światła na ten element 
może prowadzić do problemów związanych z jakością wydruków. 
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5. Unieść zieloną klapkę znajdującą się z przodu drukarki. 

 

6. Pewnie chwycić zacięty arkusz z obu stron, a następnie ostrożnie go wysunąć. 

Uwaga: Należy sprawdzić, czy usunięte zostały wszystkie fragmenty papieru. 
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7. Dopasować położenie strzałek umieszczonych na szynach bocznych wkładu światłoczułego z 
położeniem strzałek widocznych na szynach bocznych wewnątrz drukarki, a następnie wsunąć wkład 
światłoczuły do drukarki. 

 

8. Dopasować położenie szyn bocznych zasobnika na toner z położeniem strzałek widocznych na 
szynach bocznych wewnątrz drukarki, a następnie wsunąć zasobnik na toner do drukarki. 

 

9. Zamknąć przednie drzwiczki. 
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[x]-page jam, open rear door. [20y.xx] 
1. Otworzyć przednie drzwiczki, by poluzować papier zacięty w tylnych drzwiczkach. 

 

2. Ostrożnie tylne drzwiczki pociągnąć w dół. 

 OSTROŻNIE—GORĄCA POWIERZCHNIA: Wnętrze drukarki może być gorące. Aby 
zmniejszyć ryzyko obrażeń spowodowanych gorącym elementem, przed dotknięciem należy 
zaczekać, aż powierzchnia ostygnie. 
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3. Pewnie chwycić zacięty arkusz z obu stron, a następnie ostrożnie go wysunąć. 

Uwaga: Należy sprawdzić, czy usunięte zostały wszystkie fragmenty papieru. 

 

4. Zamknąć tylne drzwiczki, a następnie przednie drzwiczki. 

[x]-page jam, clear standard bin. [20y.xx] 
1. Pewnie chwycić zacięty arkusz z obu stron, a następnie ostrożnie go wysunąć. 

Uwaga: Należy sprawdzić, czy usunięte zostały wszystkie fragmenty papieru. 
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[x]-page jam, remove tray 1 to clear duplex. [23y.xx] 

 OSTROŻNIE—GORĄCA POWIERZCHNIA: Wnętrze drukarki może być gorące. Aby zmniejszyć 
ryzyko obrażeń spowodowanych gorącym elementem, przed dotknięciem należy zaczekać, aż 
powierzchnia ostygnie. 

1. Podajnik całkowicie wysunąć z drukarki. 

 

2. Odszukać zieloną dźwignię, a następnie pociągnąć ją w dół, by uwolnić zacięty papier. 
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3. Pewnie chwycić zacięty arkusz z obu stron, a następnie ostrożnie go wysunąć. 

Uwaga: Należy sprawdzić, czy usunięte zostały wszystkie fragmenty papieru. 

 

4. Wsunąć podajnik. 

[x]-page jam, open tray [x]. [24y.xx] 
1. Podajnik całkowicie wysunąć z drukarki. 

Uwaga: Komunikat na ekranie drukarki wskazuje podajnik, w którym zacięcie papieru znajduje się. 
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2. Pewnie chwycić zacięty arkusz z obu stron, a następnie ostrożnie go wysunąć. 

Uwaga: Należy sprawdzić, czy usunięte zostały wszystkie fragmenty papieru. 

 

3. Wsunąć podajnik. 

[x]-page jam, clear manual feeder. [25y.xx] 
1. W podajniku wielofunkcyjnym należy pewnie chwycić zacięty arkusz z obu stron, a następnie 

ostrożnie go wysunąć. 

Uwaga: Należy sprawdzić, czy usunięte zostały wszystkie fragmenty papieru. 

 

2. Arkusze papieru należy wygiąć do siebie i od siebie, by je poluzować, a następnie je przekartkować. 
Papieru nie należy składać, ani marszczyć. Krawędzie należy wyprostować na płaskiej powierzchni. 
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3. Ponownie załadować papier do podajnika wielofunkcyjnego. 

 

Uwaga: Należy sprawdzić, czy prowadnica papieru lekko dotyka krawędzi papieru. 

[x]-page jam, open automatic feeder top cover. [28y.xx] 
1. Z podajnika ADF należy wyjąć wszystkie dokumenty oryginału. 

Uwaga: Komunikat przestanie być wyświetlany, kiedy strony zostaną wyjęte z podajnika ADF. 

2. Otworzyć pokrywę ADF. 

 

3. Pewnie chwycić zacięty arkusz z obu stron, a następnie ostrożnie go wysunąć. 

Uwaga: Należy sprawdzić, czy usunięte zostały wszystkie fragmenty papieru. 

4. Zamknąć pokrywę ADF. 

5. Wyrównać krawędzie dokumentów oryginału, załadować je do podajnika ADF, a następnie 
dopasować położenie prowadnic papieru. 
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